Copyright

Copyright © 2007 Microsoft Corporation. All rights reserved.

Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written permission of Microsoft Corporation. Notwithstanding the foregoing, the licensee of the software with which this document was provided may make a reasonable number of copies of this document solely for internal use.

Trademarks

Microsoft, Dexterity, Excel, FRx, MapPoint, Microsoft Dynamics, Outlook, SharePoint, Visual Studio, Windows, and Windows Server are either registered trademarks or trademarks of Microsoft Corporation or FRx Software Corporation or their affiliates in the United States and/or other countries. FRx Software Corporation is a subsidiary of Microsoft Corporation. FairCom and c-tree Plus are trademarks of FairCom Corporation and are registered in the United States and other countries.

The names of actual companies and products mentioned herein may be trademarks or registered marks - in the United States and/or other countries - of their respective owners.

Unless otherwise noted, the example companies, organizations, products, domain names, e-mail addresses, logos, people, places, and events depicted herein are fictitious. No association with any real company, organization, product, domain name, e-mail address, logo, person, place, or event is intended or should be inferred.

Intellectual property

Microsoft may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject matter in this document. Except as expressly provided in any written license agreement from Microsoft, the furnishing of this document does not give you any license to these patents, trademarks, copyrights, or other intellectual property.

Warranty disclaimer

Microsoft Corporation disclaims any warranty regarding the sample code contained in this documentation, including the warranties of merchantability and fitness for a particular purpose.

Limitation of liability

The content of this document is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by Microsoft Corporation. Microsoft Corporation assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual. Neither Microsoft Corporation nor anyone else who has been involved in the creation, production or delivery of this documentation shall be liable for any indirect, incidental, special, exemplary or consequential damages, including but not limited to any loss of anticipated profit or benefits, resulting from the use of this documentation or sample code.

License agreement

Use of this product is covered by a license agreement provided with the software product. If you have any questions, please call the Microsoft Dynamics GP Customer Assistance Department at 800-456-0025 (in the U.S. or Canada) or +1-701-281-6500.

Publication date

March 2007
Contents

Introduction ................................................................................................................. 2
  What’s in this manual .................................................................................................. 2
  Symbols and conventions .......................................................................................... 3
  Resources available from the Help menu ................................................................. 3
  Send us your documentation comments .................................................................. 5

Part 1: Setup and transactions .................................................................................. 8

Chapter 1: Setup ....................................................................................................... 9
  Before you set up Multidimensional Analysis .......................................................... 9
  Multidimensional Analysis overview ....................................................................... 10
  Setting up analysis groups and codes ...................................................................... 10
  Deleting analysis groups and codes ........................................................................ 11
  Assigning analysis groups to accounts .................................................................... 12

Chapter 2: Transactions ........................................................................................... 15
  Effects of Multidimensional Analysis on other modules ........................................... 15
  Entering analysis information during transaction entry .......................................... 16
  Viewing and modifying multidimensional analysis amounts ................................... 17
  Analysis information in transactions posted to General Ledger ......................... 18
  Viewing analysis information by posting amount .................................................... 19
  Viewing analysis information by document number .............................................. 19

Part 2: Inquiries, reports, and utilities ..................................................................... 22

Chapter 3: Inquiries ................................................................................................. 23
  Performing account analysis inquiries ................................................................... 23
  Performing transaction analysis inquiries ................................................................. 23

Chapter 4: Reports ................................................................................................... 25
  Multidimensional Analysis report summary ............................................................ 25
  Specifying a Multidimensional Analysis report option ........................................... 26

Chapter 5: Utilities .................................................................................................. 29
  What reconciling does .............................................................................................. 29
  Reconciling analysis groups ..................................................................................... 29

Index .......................................................................................................................... 31
INTRODUCTION
Introduction

You can use Multidimensional Analysis to record detailed data about your transactions and perform detailed analysis of that data after you’ve posted, without creating a highly detailed chart of accounts. This is possible because you can assign an unlimited number of analysis groups and codes to individual transaction distributions.

You also can use Multidimensional Analysis to complete the following tasks:

- Set up an unlimited number of analysis codes and groups
- Combine analysis codes into groups
- Automatically apply information to transaction distributions
- Perform comprehensive inquiry and reporting

This introduction is divided into the following sections:

- What’s in this manual
- Symbols and conventions
- Resources available from the Help menu
- Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the features of Multidimensional Analysis, and how it integrates with the Microsoft Dynamics™ GP system.


Some features described in the documentation are optional and can be purchased through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using and which modules or features you are registered to use, choose Help >> About Microsoft Dynamics GP.

The manual is divided into the following parts:

- **Part 1, Setup and transactions**, walks you through setting up analysis codes and groups, and assigning them to accounts. It also describes how to enter analysis information with transactions.

- **Part 2, Inquiries, reports, and utilities**, describes how to perform inquiries by analysis group or code and how to print reports that provide information about analysis groups and codes. It also describes reconciling, the process of verifying that your Multidimensional Analysis records are accurate.
Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the glossary in Help.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Light Bulb]</td>
<td>The light bulb symbol indicates helpful tips, shortcuts and suggestions.</td>
</tr>
<tr>
<td>![Warning]</td>
<td>The warning symbol indicates situations you should be especially aware of when completing tasks.</td>
</tr>
</tbody>
</table>

This manual uses the following conventions to refer to sections, navigation and other information.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Creating a batch</strong></td>
<td>Italicized type indicates the name of a section or procedure.</td>
</tr>
<tr>
<td>File &gt;&gt; Print or File &gt; Print</td>
<td>The (&gt;&gt;) or (&gt;) symbol indicates a sequence of actions, such as selecting items from a menu or toolbar, or pressing buttons in a window. This example directs you to go to the File menu and choose Print.</td>
</tr>
<tr>
<td>TAB or ENTER</td>
<td>All capital letters indicate a key or a key sequence.</td>
</tr>
</tbody>
</table>

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance resources on your computer, as well as on the Web.

**Contents**

Opens the Help file for the active Microsoft Dynamics GP component, and displays the main “contents” topic. To browse a more detailed table of contents, click the Contents tab above the Help navigation pane. Items in the contents topic and tab are arranged by module. If the contents for the active component includes an “Additional Help files” topic, click the links to view separate Help files that describe additional components.

To find information in Help by using the index or full-text search, click the appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. Click Add.

**Index**

Opens the Help file for the active Microsoft Dynamics GP component, with the Index tab active. To find information about a window that’s not currently displayed, type the name of the window, and click Display.

**About this window**

Displays overview information about the current window. To view related topics and descriptions of the fields, buttons, and menus for the window, choose the appropriate link in the topic. You also can press F1 to display Help about the current window.
Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. For example, if the Checkbook Maintenance window is open, you can choose this item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain information before you can save the record and close the window. On the Microsoft Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
 Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within Microsoft Dynamics GP. Additional tutorials are available through the CustomerSource Web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance resources. Access to some items requires registration for a paid support plan.

  - Current implementation and upgrade information The most recent revisions of upgrade and implementation documentation, plus documentation for service packs and payroll tax updates.
  - User documentation and resources The most recent user guides, how-to articles, and white papers for users.
  - Developer documentation and resources The most recent documentation and updated information for developers.
  - Product support information  Information about the Microsoft Dynamics GP product support plans and options that are available, along with information about peer support and self-support resources.
  - Services information  Information about Microsoft Dynamics GP support, training, and consulting services.
  - Microsoft Dynamics GP Community  Access to newsgroups, where you can ask questions or share your expertise with other Microsoft Dynamics GP users.
  - CustomerSource home page  A wide range of resources available to customers who are registered for a paid support plan. Includes access to Knowledge Base articles, software downloads, self-support, and much more.
U.S. Payroll Updates
Provides access to tax updates for state and federal tax withholding. When you select an option, the process to install the updates will begin immediately. 

Check with your system administrator before installing tax updates. To be sure that tax updates are installed correctly, refer to documentation for specific tax updates on the CustomerSource Web site.

Customer Feedback Options
Provides information about how you can join the Customer Experience Improvement Program to improve the quality, reliability, and performance of Microsoft® software and services.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP documentation. If you have specific suggestions or find any errors in this manual, send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use them freely.
Part 1: Setup and transactions

Use this part of the documentation to set up analysis codes and groups, assign analysis groups to accounts, and enter analysis information with transactions. This information is divided into the following sections:

- **Chapter 1, “Setup.”** contains information about setting up Multidimensional Analysis.

Chapter 1: Setup

To use Multidimensional Analysis, you need to set up analysis codes and groups, and assign them to accounts. You generally complete setup procedures once, but you might want to refer to this material again for viewing the setup selections you’ve made, or to add, delete, or modify your analysis codes and groups.

When you’ve completed the steps described in this document, you’ll be ready to begin performing the tasks described in Chapter 2, “Transactions.”

This information is divided into the following sections:

- Before you set up Multidimensional Analysis
- Multidimensional Analysis overview
- Setting up analysis groups and codes
- Deleting analysis groups and codes
- Assigning analysis groups to accounts

Before you set up Multidimensional Analysis

Before you begin setting up Multidimensional Analysis, be sure you’ve completed the setup procedures for System Manager and General Ledger, as well as for the modules with which you’ll be using Multidimensional Analysis. You can use Multidimensional Analysis with transactions in General Ledger, Receivables Management, Invoicing, Sales Order Processing, Payables Management, and Purchase Order Processing.

For more information about completing setup procedures for a particular module, refer to the module’s documentation.
Multidimensional Analysis overview

The following flowchart describes the sequence of activities involved in setting up and using Multidimensional Analysis.

### Setting up analysis groups and codes

When you set up Multidimensional Analysis, you’ll define analysis codes and analysis groups.

**Analysis codes**  Identifiers in Microsoft Dynamics GP for items to analyze. For example, you could create analysis codes for each of your company vehicles.

**Analysis groups**  Identifiers in Microsoft Dynamics GP for a group of analysis codes. For example, you could create an analysis group for your vehicle fleet.

Use the Analysis Group Maintenance window to create the group or groups to perform detailed analysis for. For each analysis group you create, you can then define the items to analyze.
**To set up analysis groups and codes:**

1. Open the Analysis Group Maintenance window.
   (Cards >> Financial >> Analysis Groups)

2. Enter an analysis group and description. For example, you could create an analysis group for the expenses related to your company’s fleet of service vehicles.

3. Enter analysis codes and descriptions. For example, if you were creating a group for your service vehicles, you could add analysis codes for each individual vehicle, using the license number as the analysis code.

4. Choose Save to save the group and its codes. The window will remain open, so you can continue entering analysis groups.

5. Verify your entries by printing the Analysis Group Setup List. You can print this report while the Analysis Group Maintenance window is open by choosing File >> Print.

   You also can print this report using the Multidimensional Analysis Reports window. For more information, see *Specifying a Multidimensional Analysis report option* on page 26.

**Deleting analysis groups and codes**

You can delete an analysis group or code only if the following conditions apply:

- The code or group has not been assigned to an account.

- The code or group has not been assigned to a transaction that has Multidimensional Analysis information entered in an analysis posting detail window.

**To delete analysis groups and codes:**

1. Open the Analysis Group Maintenance window.
   (Cards >> Financial >> Analysis Groups)

2. Enter or select an existing analysis group.

3. To delete an analysis code from the group, highlight the code and choose Edit >> Delete Row.

4. To delete an analysis group, choose the Delete button.
Assigning analysis groups to accounts

Use the Account Analysis Defaults window to assign analysis groups to accounts you want to track detailed analysis information for. For example, if you created an analysis group for your service vehicle expenses, you would assign that group to each of the accounts that record your vehicle expenses. You can assign multiple analysis groups to an account.

**Analysis groups can be assigned only to posting accounts.**

For each analysis group assigned to an account, you’ll indicate an analysis type—whether or not analysis amounts should be recorded every time a transaction is posted to that account. You also can enter percentages to determine the amounts recorded during transaction entry.

All Multidimensional Analysis group types can be used with writeoff accounts. In Receivables Management, debit memos using either the receivables or overpayment writeoff account will not post if the Multidimensional Analysis groups for the account don’t equal one hundred percent.

The following table lists the analysis types you can choose for an analysis group.

<table>
<thead>
<tr>
<th>Analysis type</th>
<th>Allowed changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Codes can be added or deleted. If any codes and amounts are entered, the total must equal the posting amount before you post.</td>
</tr>
<tr>
<td>Required</td>
<td>Codes must be entered. The default amounts for the codes can be changed or removed, as long as the total amount equals the posting amount before you post.</td>
</tr>
<tr>
<td>Fixed</td>
<td>Codes must be recorded and the total amount must equal the posting amount before you can save or post. The default amounts recorded for the codes cannot be changed or removed.</td>
</tr>
<tr>
<td>None</td>
<td>No analysis codes or amounts can be entered when entering Multidimensional information about a transaction. You can use this analysis type when you want to prohibit analysis for an analysis group, but you don’t want to delete the group.</td>
</tr>
</tbody>
</table>

**To assign analysis groups to accounts:**

1. Open the Account Analysis Defaults window.  
   (Cards >> Financial >> Analysis Defaults)
2. Enter or select an account.

3. Enter or select an analysis group to apply to this account.

4. Indicate whether to allow quantities to be entered during transaction entry in addition to currency amounts. You can specify quantities to be entered for each analysis group you’ve assigned to the account.

   For example, if you have an analysis group to track printing expenses, you could use this field to track the number of cases of paper purchased. The quantity information is for reporting purposes only and doesn’t affect posting.

5. If you’ve marked Quantities, select the number of decimal places that will be used to display quantities.

6. Select an analysis type. That is, specify whether entering amounts against the analysis codes in this group during transaction entry is optional or required, and if it’s required, whether or not the amounts can be changed.

7. Enter or select the analysis codes in the selected group that should be applied to this account.

8. Enter a posting description and a default percentage amount for each code.

9. Choose Save.

   When transactions involving the account are posted, the distribution amount will be allocated across all of the default codes by the appropriate percentages.
Chapter 2: Transactions

You can enter analysis information when you enter transactions in General Ledger, Receivables Management, Invoicing, Sales Order Processing, Payables Management, and Purchase Order Processing.

Posting reports will be printed when you post transactions, either individually or in batches. For more information about posting reports for Multidimensional Analysis, refer to Chapter 4, “Reports.”

For more information about setting up posting, see the System Setup Guide (Help >> Printable Manuals>> select System >> select System Setup Guide).

This information is divided into the following sections:

- Effects of Multidimensional Analysis on other modules
- Entering analysis information during transaction entry
- Viewing and modifying multidimensional analysis amounts
- Analysis information in transactions posted to General Ledger
- Viewing analysis information by posting amount
- Viewing analysis information by document number

Effects of Multidimensional Analysis on other modules

When you’re using Multidimensional Analysis, you should be aware of the following effects:

- Deleting a batch of transactions or an individual transaction also deletes the analysis information entered on the transaction.

- Voiding a transaction that has been posted to General Ledger removes the analysis information from the transaction.

- Posting a transaction with an optional analysis group whose codes don’t have any amounts deletes the analysis information.

You also should be aware of how Multidimensional Analysis works with other modules. Refer to the table for more information.

<table>
<thead>
<tr>
<th>Module</th>
<th>Document types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receivables Management</td>
<td>You can use Multidimensional Analysis with all document types.</td>
<td></td>
</tr>
<tr>
<td>Payables Management</td>
<td>You can use Multidimensional Analysis only with transactions entered on the transaction entry windows. You can’t use Multidimensional Analysis when creating payments in Payables Management.</td>
<td></td>
</tr>
</tbody>
</table>
Entering analysis information during transaction entry

If a transaction includes distributions to an account that you have assigned analysis groups to, Multidimensional Analysis automatically will record amounts against the analysis codes according to the default percentages you entered in the Account Analysis Defaults window.

If you need to view and modify these amounts, do so using the following analysis posting detail windows:

<table>
<thead>
<tr>
<th>Module</th>
<th>Transaction entry window</th>
<th>Analysis posting detail window</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Ledger</td>
<td>Transaction Entry window</td>
<td>Analysis Posting Detail window</td>
</tr>
<tr>
<td>Invoicing</td>
<td>Invoice Entry window</td>
<td>Invoice Analysis Posting Detail window</td>
</tr>
<tr>
<td>Payables Management</td>
<td>Payables Transaction Entry window Payables Manual Payment Entry window Edit Payables Checks window</td>
<td>Payables Analysis Posting Detail window</td>
</tr>
</tbody>
</table>
The procedure for viewing and modifying the amounts recorded against the analysis codes is the same for all of the analysis posting detail windows. Refer to Viewing and modifying multidimensional analysis amounts on page 17 for more information.

For information about the other analysis posting detail windows, refer to online help.

### Viewing and modifying multidimensional analysis amounts

You’ll use one of several analysis posting detail windows to view and modify the amounts recorded against the analysis codes assigned to an account, depending on the transaction entry window used to create the transaction. Refer to Entering analysis information during transaction entry on page 16 for more information about which analysis posting window is used with which transaction window.

The basic process is the same for all of these windows, but each window requires different navigation. The following procedure describes how you can use the Analysis Posting Detail window to view information about a General Ledger transaction.

**To view and modify multidimensional analysis amounts:**

1. Open the Transaction Entry window.  
   (Transactions >> Financial >> General)
2. Enter or select a transaction that includes a distribution to an account you have assigned analysis groups to, and choose to view the distributions.

   In General Ledger, account distributions are displayed directly in the Transaction Entry window. In other transaction entry windows you might need to choose the Distributions button to open a distributions window.
3. Highlight an account you’ve assigned analysis groups to, and choose the Account Analysis button.

   ![Account Analysis button]

   You also can choose View >> Analysis to open the Analysis Posting Detail window.
The Analysis Posting Detail window opens. Any analysis groups assigned to this account will appear in this window.

4. Select a group to view the analysis codes and default amounts. Depending on the analysis type of the group, you might be able to make changes to the codes and the amounts for each code.

   After making changes, you can choose Default to restore the default analysis groups and amounts. You also can allocate any remaining amount to any codes with an amount of zero by choosing Auto Allocate. For example, to allocate the entire amount of a distribution to a single code, you can delete all the other codes (select each code and choose Edit >> Delete Row), enter a zero amount in the remaining code and then choose Auto Allocate.

5. Choose OK to save your changes and close the Analysis Posting Detail window.

### Analysis information in transactions posted to General Ledger

If you’re posting in summary to General Ledger, the analysis detail information will be retained even if the General Ledger account amounts are posted in summary. You’ll be able to view the detail analysis information by using browse buttons in the Analysis Posting Detail window and the Analysis Inquiry window.

For information about creating a single journal entry for the batch total of each account, as well as other posting setup options, see the System Setup Guide (Help >> Printable Manuals>> select System >> select System Setup Guide).

The Posting Amount browse buttons are available when the original transaction has two or more distributions using the same account. The Document Number browse buttons are available when two or more transactions using the same posting accounts are saved in a batch.
Viewing analysis information by posting amount

Assume that you set up the Purchase Expense account, 1000-1000-0000-5166-0000, to track analysis information. In the Payables Management module, assume that you’ve entered the following transaction with two distributions using the same account in a batch.

<table>
<thead>
<tr>
<th>Account</th>
<th>Distribution Type</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000-1000-0000-5166-0000</td>
<td>PURCH</td>
<td>$100</td>
<td></td>
</tr>
<tr>
<td>1000-1000-0000-5166-0000</td>
<td>MISC</td>
<td>$10</td>
<td>$110</td>
</tr>
<tr>
<td>1000-1000-0000-2120-0000</td>
<td>PAY</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you post the batch to General Ledger in summary, the following journal entry will be created in General Ledger:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000-1000-0000-5166-0000</td>
<td>$110</td>
<td></td>
</tr>
<tr>
<td>1000-1000-0000-2120-0000</td>
<td></td>
<td>$110</td>
</tr>
</tbody>
</table>

When you view the analysis information for the Purchase Expense account in the Analysis Posting Detail window or its inquiry window, the Posting Amount browse buttons will be available. You can use the browse buttons on the Posting Amount field to view additional distributions for the account.

Viewing analysis information by document number

Assume that you set up the Purchase Expense account, 1000-1000-0000-5166-0000, to track analysis information. In the Payables Management module, assume that you’ve entered the following two transactions in the same batch.

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>PM00052</td>
<td>1000-1000-0000-5166-0000</td>
<td>$100</td>
<td></td>
</tr>
<tr>
<td>PM00052</td>
<td>1000-1000-0000-2120-0000</td>
<td></td>
<td>$100</td>
</tr>
<tr>
<td>PM00053</td>
<td>1000-1000-0000-5166-0000</td>
<td>$250</td>
<td></td>
</tr>
<tr>
<td>PM00053</td>
<td>1000-1000-0000-2120-0000</td>
<td></td>
<td>$250</td>
</tr>
</tbody>
</table>

When you post the batch to General Ledger in summary, the following journal entry will be created in General Ledger:

<table>
<thead>
<tr>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000-1000-0000-5166-0000</td>
<td>$350</td>
<td></td>
</tr>
<tr>
<td>1000-1000-0000-2120-0000</td>
<td></td>
<td>$350</td>
</tr>
</tbody>
</table>
When you view the analysis information for the Purchase Expense account in the Analysis Posting Detail window or its inquiry window, the Document Number browse buttons will be available. You can use those browse buttons to view the analysis amounts for each document.
Part 2: Inquiries, reports, and utilities

Use this part of the documentation to perform inquiries by analysis group or code and print reports that provide information about analysis groups and codes. This part also contains information about the reconciliation utility used to verify that your Multidimensional Analysis records are accurate. This information is divided into the following sections:

- **Chapter 3, “Inquiries,”** explains how to access detailed and summarized Multidimensional Analysis information.

- **Chapter 4, “Reports,”** guides you through using Multidimensional Analysis reports.

- **Chapter 5, “Utilities,”** explains the process of reconciling Multidimensional Analysis records.
Chapter 3: Inquiries

Inquiry windows provide easy access to detailed and summarized Multidimensional Analysis information. Not only can you perform inquiries by analysis group or code, you also can click links to view analysis detail inquiry windows from many of the distribution inquiry windows in Microsoft Dynamics GP.

This information is divided into the following sections:

- Performing account analysis inquiries
- Performing transaction analysis inquiries

Performing account analysis inquiries

Multidimensional Analysis lets you view the analysis breakdowns for individual accounts. You can open account analysis detail inquiry windows from the following windows:

- Invoice Distribution Inquiry window
- Journal Entry Inquiry window
- Payables Distribution Zoom window
- Purchasing Distribution Inquiry Zoom window
- Receivables Distributions Inquiry Zoom window
- Sales Distribution Inquiry Zoom window
- Transaction Entry Zoom window

When you select an account that has analysis information, an Account Analysis button becomes available. To display an analysis detail inquiry window, select an account for which analysis codes have been assigned, then choose the Account Analysis button or choose View >> Analysis.

Performing transaction analysis inquiries

Use the Analysis Inquiry window to view the transactions that have been recorded against the codes in a selected group. You can view unposted transactions, as well as posted transactions in open and historical years. In addition, you can view detailed information about the originating documents by selecting a transaction and clicking the Document Number link.
To perform a transaction analysis inquiry:

1. Open the Analysis Inquiry window.
   (Inquiry >> Financial >> Analysis)

2. Enter or select the analysis group and code to view transaction information for.
   You can view unposted transactions, as well as posted transactions in open and historical years. You can sort the transactions by account, by document number, by document date, or by posting date.

3. To view detailed information about a transaction, select the transaction and click the Document Number link.
Chapter 4: Reports

You can use Multidimensional Analysis reports to provide detailed or summary information about analysis groups and codes. These reports can include both posted and unposted transactions. You also can print setup lists showing your analysis groups and codes, and the accounts they have been applied to.

This information is divided into the following sections:

- Multidimensional Analysis report summary
- Specifying a Multidimensional Analysis report option

Multidimensional Analysis report summary

You can print several types of reports using Multidimensional Analysis. Some reports, such as utility reports, automatically are printed when you run the corresponding utility procedure. In order to print most setup or analysis reports, you must set up report options to specify sorting options and ranges of information to include on the report. For more information, refer to Specifying a Multidimensional Analysis report option on page 26.

The following table lists the report types available in Multidimensional Analysis and the reports that are in each type.

<table>
<thead>
<tr>
<th>Report type</th>
<th>Report</th>
<th>Printing method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup reports</td>
<td>Analysis Group Setup List</td>
<td>Choose File &gt;&gt; Print in the Analysis Group Maintenance window or create report options in the Multidimensional Analysis Reports window.</td>
</tr>
<tr>
<td>Utility report</td>
<td>Reconcile Group Balances Report</td>
<td>This report will be printed when you complete the corresponding procedure.</td>
</tr>
</tbody>
</table>
Specifying a Multidimensional Analysis report option

Report options include specifications for sorting options and range restrictions for a particular report. In order to print several Multidimensional Analysis reports, you must first create a report option. Each report can have several different options so that you can easily print the information you need. For example, you can create report options for the Account Analysis Report that show either detailed or summary information.

A single report option can’t be used by multiple reports. If you want identical options for several reports, you must create them separately.

Use the Multidimensional Analysis Reports window to create report options for the reports that have been included with Multidimensional Analysis.

To create a report option:

1. Open the Multidimensional Analysis Reports window. (Reports >> Financial >> Multidimensional Analysis)

2. Select a report from the Reports list.

3. Choose New to open the report options window.

4. Name the option and enter information to define the option. The name you choose for the option won’t appear on the report.

The selections available for defining report options vary, depending on the report type you’ve selected. Refer to the table for more information.

<table>
<thead>
<tr>
<th>Report</th>
<th>Available selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Group Setup List</td>
<td>Ranges: Analysis Group ID</td>
</tr>
<tr>
<td>Account Analysis Setup Report</td>
<td>Detailed/Summary Ranges: Segment ID</td>
</tr>
<tr>
<td>Account Analysis Report</td>
<td>Detailed/Summary Include: Unposted, Open, History Ranges: Segment ID, Transaction Date, Posting Date, Analysis Group ID, Analysis Code ID</td>
</tr>
</tbody>
</table>

5. Enter range restrictions. The Ranges list shows the available options for each report.

You can enter only one restriction for each restriction type. For instance, you can insert one Analysis Group ID restriction.
6. Choose Insert to insert the range in the Restrictions list. To remove an existing range from the list, select the range and choose Remove.

7. Choose Destination to select a printing destination. Reports can be printed to the screen, to the printer, to a file or to any combination of these options. If you select Ask Each Time, you can select printing options each time you print this report option.

8. To print the report option from the report options window, choose Print before saving it. If you don’t want to print the option now, choose Save and close the window. The report window will be redisplayed.
Chapter 5: Utilities

Multidimensional Analysis includes a reconciliation utility that you can use to verify the accuracy of records and to correct certain data errors.

The following information is discussed:

- **What reconciling does**
- **Reconciling analysis groups**

**What reconciling does**

Reconciling is the process of verifying that your Multidimensional Analysis records are accurate. You should use this utility only if the total amount recorded for an analysis group doesn’t equal the sum of the amounts recorded for its individual analysis codes.

The reconciliation process performs the following operations:

- It deletes the analysis group record for any transaction that has analysis groups but no analysis codes, provided that the transaction has been posted through General Ledger or is in history.
- It adjusts the group total if the group total doesn’t match the total of all the group’s codes.
- It deletes analysis codes that aren’t assigned to an analysis group.

When processing is finished, the Reconcile Group Balances report is printed. The report lists the analysis groups that were reconciled.

**Reconciling analysis groups**

Use the Reconcile Analysis Groups utility to ensure that the total amount recorded for analysis groups equals the sum of the amounts recorded for individual analysis codes.

**To reconcile analysis groups:**

1. Open the Reconcile Analysis Groups window. 
   (Microsoft Dynamics GP menu >> Tools >> Utilities >> Financial >> Reconcile Analysis)

2. Select whether to reconcile and print the Reconcile Group Balances report, or print the reconcile report without reconciling information.

Print the report without reconciling if you want to find out whether reconciliation is necessary, or if you want to know what operations the utility would perform.
3. Choose Process to reconcile analysis groups.

When the processing is complete, the Reconcile Group Balances report will be printed.
Index

A
Account Analysis button 23
Account Analysis Defaults window
assigning analysis groups 12
displaying 12
accounts in General Ledger, analysis information 18
analysis codes
deleting 11
described 10
reports 25
setup 10
Analysis Detail Inquiry Zoom window,
displaying 23
Analysis Group Maintenance window
creating groups 11
deleting codes and groups 11
displaying 11
analysis groups
analysis types 12
assigning 12
deleting 11
described 10
printing a list 11
reconciling 29
reports 25
restoring default values 18
setup 10
analysis information
effects of deleting 15
viewing
by document number 19
by posting amount 19
for accounts 23
for transactions 23
Analysis Inquiry window
displaying 24
viewing, analysis information 18
viewing codes in groups 24
viewing transactions in groups 24
Analysis Posting Detail window
displaying 18
modifying analysis amounts 18
viewing
analysis amounts 18
analysis information 18
analysis types, described 12
C
changes since last release, information about 4
current upgrade information, accessing on the Web 4
D
documentation, symbols and conventions 3
F
flowcharts, Multidimensional Analysis 10
H
help, displaying 3
Help menu, described 3
history in Multidimensional Analysis
moving analysis information to 16
reconciling 29
I
icons, used in manual 3
invoices in Multidimensional Analysis,
entering analysis information 16
L
lessons, accessing 4
lookup, accessing 4
M
Multidimensional Analysis Reports
window
creating a report option 26
displaying 26
N
navigation, symbols used for 3
new features, information about 4
O
Orientation training, accessing 4
P
posting in General Ledger, retaining
analysis information 18
posting in Multidimensional Analysis
modifying amounts 16
moving analysis information to
history 16
optional analysis groups 15
reversing analysis information 16
viewing analysis information 19
R
receipts in Multidimensional Analysis,
updating analysis information 16
Reconcile Analysis Groups window
displaying 29
reconciling analysis groups 29
Reconcile Group Balances report, printing 29
reconciling in Multidimensional Analysis
explanation of 29
reports on 25
report options, creating 26
reports in Multidimensional Analysis
(continued)
Reconcile Group Balances Report 25, 29
restricting 26
sorting 26
required fields, described 4
resources, documentation 3
returns in Multidimensional Analysis,
entering analysis information 16
S
setup in Multidimensional Analysis
analysis codes, creating 10
analysis groups
assigning to accounts 12
creating 10
before you begin 9
overview 10
setup reports 25
symbols, used in manual 3
T
Transaction Entry window
analysis amounts
modifying 17
viewing 17
displaying 17
transactions in General Ledger, analysis information 18
transactions in Invoicing, analysis information 16
transactions in Multidimensional Analysis
allocating amounts 18
analysis inquiries 23
analysis types 12
effects of deleting a batch 15
effects of voiding 15
entering analysis information 16
modifying amounts 17
reconciliation process 29
reports 25
reversing transactions 16
viewing amounts 17
transactions in Purchase Order Processing, analysis information 16
transactions in Sales Order Processing,
analysis information 16
tutorial, accessing 4
U
upgrade information, accessing on the Web 4
W
what’s new, accessing 4